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* A text editor 1s a computer program that lets a user enter, change, s
store, and usually print text (characters and numbers, each
encoded by the computer and its mput and output devices,
arranged to have meaning to users or to other programs). ™

* Typically, a text editor
"scrollable page") with

provides an "empty" display screen (or
a fixed-line length and wvisible line

numbers. You can then fil

| the lines in with text, line by line.*

* The word processor has replaced the typewriter as a way to
generate print writing, and features items like margins, spell check
and fonts which accommodate different types of presentation for

letters, documents, etc.**

*https://whatis.techtarget.com/definition/text-editor
**https://www.techopedia.com/definition/5478/text-editor
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* With Word on your PC, Mac, or mobile device, you can:
* Create documents from scratch, or a template.

* Add text, images, art, and videos.

* Research a topic and find credible sources.

* Access your documents from a computer, tablet, or phone with
OneDrive.

* Share your documents, and work with others.

* Track and review changes.

*https://support.office.com/en-gb/article/create-a-document-in-word-aafc163a-3a06-45a9-b451-
cb7250dcbaal?wt.mc_id=otc_word
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] Edit DOCument ADMINISTRATION IN KARVINA

» Word offer many time saving features to help you edit text in a
document. You can add, delete & rearrange text. You can also quickly
count the number of words in a document. Check your document for

spelling & grammar errors & use words the thesaurus to find more
suitable words.

e Format Document

* You can format a document to enhance the appearance of the document
you can use various font, styles and colours to important text. You can

also adjust the spacing between lines of text, changes the margins and
create newspaper columns.

*https://sciencetutorz.blogspot.com/2017/11/microsoft-word-2016.html



Microsoft Word — some features® mm@
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] Edit Images ADMINISTRATION IN KARVINA

» Ms Word 2010, 13 & 16 includes a palette of artistic tool & filters you
can apply to 1images 1n your documents.

* Tables & Graphics

» You can format a document to enhance the appearance of the document
you can use various font, styles and colours to important text. You can
also adjust the spacing between lines of text, changes the margins and
create newspaper columns.

 Business Talks

» Ms Word 2016 offers you to business talk with your Microsoft account
using the skype. Using this feature, you can create skype chat groups and
work with your group members online on a single project.

*https://sciencetutorz.blogspot.com/2017/11/microsoft-word-2016.html
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* Formatting text in Microsoft Word involves tasks like: Ak frirish 3 Ky
» bolding the text;
> italicising it,
» changing the font;
» changing the size.

* The commands to perform all of these formatting tasks are found
on the Home tab 1n the Font group.

* Select your text and then click on the required formatting button
to see the effects.

*http://www.electricteacher.com/wformat.htm



Microsoft Office Word*
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Microsoft Word - Options
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*https://answers.microsoft.com/en-us/msoffice/forum/all/writing-style-option-is-grayed-out-disabled-in-ms/f8492425-

le2b-4c65-8eal1-11781eb0c52f
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* Select some text in your document that represents the formatting oo e
you want to change. It could be just one word.*
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*https://www.laptopmag.com/articles/select-text-similar-formatting-word
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* Formatting text — Home/Font ARaa S s

Font 7 > Font ? x
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Character Spacing
Font: Font style: Size: scale: 100% "
Arial Bold 14 o
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*https://www.windowscentral.com/how-change-font-defaults-microsoft-word-2016-windows
**https://wordribbon.tips.net/TO06009_Adjusting_the Width_of Characters.html



Microsoft Word — text formatting

* https://www.digiruns.com/font-text-formatting-in-microsoft-

word/
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Microsoft Word — paragraphs mm@

* A paragraph in Word 1s any text that ends with a hard return. You ZEIES0Y
insert a hard return anytime you press the Enter key.* S

* Paragraph formatting lets you control the appearance 1f individual
paragraphs.*

* For example, you can change the alignment of text from left to
center or the spacing between lines form single to double.*

* You can indent paragraphs, number them, or add borders and
shading to them.*

* Paragraph formatting 1s applied to an entire paragraph.*

* All formatting for a paragraph 1s stored in the paragraph mark and

carried to the next paragraph when you press the Enter key. ™
*https://www.mediacollege.com/microsoft/word/paragraph.html



Microsoft Word — paragraphs*
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*https://www.howtogeek.com/256909/how-to-stop-a-paragraph-from-splitting-between-pages-in-microsoft-word/
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Preview
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*https://support.office.com/en-us/article/indent-the-first-line-of-a-paragraph-b3721167-e1c8-40c3-8a97-3f046fc72d6d
**https://www.officetooltips.com/word_2016/tips/how_to_keep lines_and_paragraphs_together_in_a_ word_document.html



Microsoft Word — styles® mm@

UNIVERSITY

SCHOOL O BUSINESS
ADMINISTEATION IM KAEYINA

* A style 1s a predefined combination of font style, color, and size
that can be applied to any text in your document.

* Styles can help your documents achieve a more professional look
and feel.

* You can also use styles to quickly change several things in your
document at the same time.

B € - Animal Rescue - Word
File Home Insert Layout References Mailings Review View Q Tellr
— - Tde T Tite
- . . Title T . -
awdey ) ke tenmen 1 Heamol “-H":'-
Themes [P | o S o :':m_",':;':j"'___-'"“__ ——— o === @
Document Formatting

*https://edu.gcfglobal.org/en/word2016/applying-and-modifying-styles/1/



Microsoft Word — styles®

* From the Design tab, click
the More drop-down arrow 1n
the Document Formatting

group.

* Choose the desired style set
from the drop-down menu.

Aal This Document

Themes i

s e 1, e st i 1

R,

* The selected style set will be
applied to your entire
document.

Reset to the Default Style Set

Save as a New Style Set...

*https://edu.gcfglobal.org/en/word2016/applying-and-modifying-styles/1/
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¢ You Can also quiCkly Sample.docx - Word 7 P i o T |- % 4
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*https://www.howtogeek.com/220776/how-to-set-paragraph-formatting-in-word/
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 J Find the Style you Want Sample.docx - Word o o R o |
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*https://www.howtogeek.com/220776/how-to-set-paragraph-formatting-in-word/



Microsoft Word — styles®

* Select options on the “Modify
Style” dialog box to change
the formatting to what you
want.

* Click the “Format™ button for
access to additional formatting
options.*
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*https://www.howtogeek.com/220776/how-to-set-paragraph-formatting-in-word/
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o . Font Ta Paragraph IF} Styles
To apply the formatting — .
changes to all new documents e
Hame: Mormal LY jul
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* Bulleted and numbered lists can be used in your documents to S,
outline, arrange, and emphasize text.

* Select the text you want to format as a list.

Agenda

Call to order

New member introduction
Treasurer’s report

News and events
Communications

New TTI Facebook Fage

N

*https://edu.gcfglobal.org/en/word2016/lists/1/



Microsoft Word — bulleted lists*

* On the Home tab, click
the drop-down arrow
next to the Bullets
command. A menu of
bullet styles will appear.

e Move the mouse over the

various bullet styles. A AW A -

live preview of the bullet

document. Select the
bullet style you want to
use.

*https://edu.gcfglobal.org/en/word2016/lists/1/

F
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References Mailings [ o Tell me what you war
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¥

Cancel

*https://edu.gcfglobal.org/en/word2016/lists/1/
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*https://edu.gcfglobal.org/en/word2016/lists/1/
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Microsoft Word — bulleted lists*

* To remove numbers or bullets from a list,

select the list and click the Bulleted
Numbered list command.

or

* When you're editing a list you can press Enter
to start a new line, and the new line will
automatically have a bullet or number. When
you've reached the end of your list, press Enter

twice to return to normal formatting.

* By dragging the indent markers on the Ru
you can customize the indenting of your
and the distance between the text and the bul
or number.

*https://edu.gcfglobal.org/en/word2016/lists/1/
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Microsoft Word — numbered lists* mm@
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 Numbered lists are created in a manner similar to bulleted lists,
except that instead of bullets Word places sequential numbers.

* This 1s a very useful feature, because if you add a paragraph in
the middle of a numbered list or rearrange the order of the
paragraphs 1n a list, Word automatically renumbers the
paragraphs so that they retain their sequence.

* On the Home tab, in the Paragraph group, click Bullets or
Numbering.

Paragraph M

*https://www.officetooltips.com/word_2016/tips/creating_numbered_lists.html



Microsoft Word — numbered lists*

* You can find different bullet
styles and numbering formats
by clicking the arrow next to

- 1:'i—_'v E E -fr'l 1"’

4
[11

Recently Used Number Formats

II *EE
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2.

Bullets or Numbering on the
Home tab, in the Paragraph Humbering oy
group. e ||2 2
3 3)
 You can move an entire list to |_ \ )

m .

the left or the right. Click a . > ”
bullet or number in the list,

and drag 1t to a new location. . i
The entire list moves as you '
drag. The numbering levels do Define New Number Format.

not change.
*https://www.officetooltips.com/word_2016/tips/creating_numbered_lists.html
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Paste Options:
20 il e

= Lo LA
Adjust List Indents...
Bestart at 1
Continue Mumbering

Set Numbering Yalue...
Eont...
Paragraph...
Srart Lookup
Synonyrms
Translate
Hyperlink...

Mew Comment

b A‘ 'E," ¢ &.’ " b

I U3~ A -:= -5~ Styles



Microsoft Word — heading multilevel numbering*
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R View Developer Help

i e (T =t = -
o= = AT sae., | Heading1 | Heading 2
Current List
Styles
i le— e [3 i A
A
L—
List Library
1) 1.
Video Mone aj 1
Wideo provil N TRl cligk Online Video, you can
pasteE i the | 14 pe & keyword ta dasnch anling far
the videoth 1.1.1 Hea ——
* ALY 4y 1§ s 4———
Profession | . Section § 11,101 Hasteg t——
T e e fayeiass] 100000 Feageg o ieadler, foater, cover page, and
test boo des BEEEETERET 3 o matching cover page, header,
and sidebar 1100 Headng § he ditferent galieries
i Chaot 10,100,010, Hassng
Themes | | i
Themes ang i youu click Design and choose a new
Theme, the i = FOUT P Thasmee, WRER Yol APy
Fyles, your
Efficient
Save time in Define New Multevel List, 1. To change the way & pictiane
fits i your ¢ Eac | next 10 It When you work on a
b £k 4 Define Mew List Style... b pleis slgn
Readakbility

RendEng is sazier, 100, in the new Reading view. You can coBapse pars of the dodusment and fomis on

the et you want. i you need to stop repding before you resch the end, Word remembers whers you
|eft aff - Even on ancther desice.
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Define new Multilevel list e X
Click level to modify:
1 Heading 1
3
4 1.1 Heading 2=
5 1.1.1 Heading 3
6 1.1.1.1 Heading 4
g 1.1.1.1.1 Heading 5
9 1.1.1.1.1.1 Heading &
1.1.1.1.1.1.1 Heading 7
1.1.1.1.1.1.1.1 Heading 8
1.1.1.1.1.1.1.1.1 Heading 9
Number format

Enter formatting for number:

1 Font...
Number style for this level: Include level number from:
123 .. v v
Position
Number alignment: | | o4 | Alignedat: [g :
Text indent at: 0.3 5 | setfor All Levels...
More >> Cancel

*https://www.techrepublic.com/article/how-to-create-multilevel-numbered-headings-in-word-2016/
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